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Congratulations on your purchase of the Bushnell ImageView® binocular! The 

Bushnell ImageView binocular takes the technology of digital photography 

and combines it with a high-quality compact binocular.  This allows you 

to observe sporting events, wildlife, scenic vistas or anything you would 

normally use a binocular for, and then save the image in a built-in attached 

digital camera.  You can then download these images to your computer and e-

mail them to your friends and family, print off the picture using the included 

software or save them in a photo album for future use. Before using the 

product, please read the instructions contained in this manual and take time 

to familiarize yourself with the different parts and features of the product.
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INSTALL BATTERIES 
insert 2 AAA batteries (alkaline, lithium, or NiMh) as indicated inside the battery compartment on 
the bottom of the imageView.

ADJUST THE BINOCULAR FOR COMFORTABLE VIEWING
Adjust the center focus knob while viewing a distant object through the binocular, until it appears 
sharp. Move the left and right sides of the binocular closer together or farther apart until you see 
a single circular image. Rotate the right eyepiece (diopter adjustment) to change the setting if the 
image does not appear as sharp to your right eye as it does to your left eye.

TURN ON THE CAMERA 
Press the MODE button briefly, then release it. You will see a battery indicator and 3 digits indicating 
the number of photos taken (currently stored in the internal memory).  As you take new photos, this 
counter will advance. Press and hold MODE to turn off the camera. You should download all photos 
before changing batteries or storing the camera unused for a long period of time (more than a few 
weeks) as a precaution.

CHECK CAMERA SETTINGS
Make sure the camera is set for high resolution and quality (refer to pg.8, "Setup Menu") if you want 
the best results, especially if you will be printing the photos. See “Changing Operational Modes” for 
full instructions covering features such as continuous shot,  shooting a video clip, and how to delete 
a photo you have just taken. 

QUICK GUIDE: BUSHNELL IMAGEVIEW 11-8338

FINAL 118338 QVC Imageview 1LIM 3   3 9/17/07   7:48:03 PM



TAKE A PHOTO (TIPS FOR BETTER QUALITy PHOTOS)
Holding the imageView as steadily as possible with both hands wrapped around the  binocular, lightly 
press down the SNAP button using the flat end of a finger. Leaning against a wall, tree, etc. to brace 
yourself can also help insure the camera does not move as you take the photo. Make sure you are at least 
30 feet or more away from your photo subject. Unlike the binocular optics (which will focus down to about 
15 ft.), the camera focus is preset and is designed only for distant subjects- your photos may look out of 
focus if you were too close. 

USING THE IMAGEVIEW WITH yOUR COMPUTER
if you are using Windows 98, install the driver from the CD-ROM as directed in “Software installation” 
before connecting the imageview to your PC (no driver is necessary with other operating systems). if 
desired, you may install Roxio® PhotoSuite 5 from the CD-ROM, following the on-screen instructions 
(if you do not already have photo software you prefer to use. Note: PhotoSuite is not compatible with 
Windows Vista or Mac OS9/OSX). Connect the supplied USB cable between the imageView and your 
computer, using a USB port on the computer itself (avoid USB “hubs”). Please read “Downloading Photos 
to Your Computer” for detailed instructions on transferring photos to a PC or Mac computer.

QUICK GUIDE: BUSHNELL IMAGEVIEW 11-8338
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Congratulations on your purchase of a Bushnell imageView binocular. Before using the product, 
please read these instructions and take time to familiarize yourself with the different parts and 
features of the product.

BASIC OPERATION     

TURNING THE CAMERA ON AND OFF
insert 2 AAA alkaline batteries as indicated on the inside of the 
battery compartment, located on the bottom of the camera unit. 
turn the camera on by pressing and holding the MODE button 
until the display comes on and the camera beeps. to turn the unit 
off, press and hold the MODE button until the display goes out. 
the camera will turn itself off automatically to save batteries if 
none of the buttons have been pressed for two minutes.

TAKING A PICTURE
With the camera turned on, press the SNAP button to take a new 
photo. For best results, hold the ImageView steady using both 
hands, and lightly press down the SNAP button using the flat 
end of your finger rather than “punching” it with a fingertip. Be 
sure you are at least 35 feet away from your subject as the camera 
focus is preset for optimum results with distant objects (sports, 
wildlife, etc.).

SNAP 
(Shutter 
Release)

MODE
(Power)

FINAL 118338 QVC Imageview 1LIM 5   5 9/17/07   7:48:04 PM



�

LCD DispLay
  1.   High Quality Mode (less file compression) 
  2.   Deletes all the pictures in the memory.
  3.   Low Quality Mode (more file compression)
  4.   Deletes the last picture taken.

  5.   Select the timer to take a delayed picture. This gives you  
   approximately a 10-second delay.

  6.   SD mark appears when an SD card is inserted.
  7.   This mode allows you to take short movie clips, saved as “.avi” files.
  8.   USB mark appears when USB cord is connected between the camera and the PC.
  9.   Battery mark keeps track of the battery life left.
10.    Indicates Resolution setting (4 stars=highest resolution, 1 star=lowest resolution) 
11.    This section of the display is used for three different types of indication:
    

BasiC OpERaTiON
1. The camera is powered by two AAA alkaline (included), lithium or rechargeable NiMh batteries.
2.  Insert the batteries into the battery compartment. If greater storage for photos/videos is desired (the internal 

memory capacity is approx 6MB), insert an SD card ("upside down" with metal contacts facing up) in the card 
slot. You may use SD cards up to 1 GB. To remove an SD card, simply pull it straight out of the card slot.

3.  Press and hold the MODE button until the camera turns on.
4.  Press SNAP to take a picture, or press the MODE button quickly to change mode settings as described above. The 

camera is set at infinity and will not be focused on an object closer than approx. 35 feet.

a. Photo Number-in normal operation, the number of photos stored (in internal or card memory) is seen here.
b. Memory Full-when the memory is full, the display indicates “FUL” here. Download your photos, then “Delete 
All” to take more. Or change to a new, blank SD card. 
c. Setup Menu-displays the current setting for each of the 4 options in the Setup Menu
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CHANGING OPERATIONAL MODES
Pressing the MODE button briefly will cycle through several special camera modes and settings. A 
corresponding icon or symbol (indicated in parentheses below) will be displayed on the LCD for each mode 
or setting as you cycle through them by tapping the MODE button.  When the icon for a mode or setting is 
displayed, pressing SNAP will select that mode or change that setting. If no button is pressed for more than 
5 seconds, the camera will return to normal operation. The modes/settings are shown as you cycle through 
them in the following order: 

• Timer (        ) : selects the self-timer, which will take a photo after a 10 second delay when you press the 
SNAP button. This can be used to avoid moving or shaking the camera by pressing the SNAP button 
when the camera is placed on a table or other level surface. A series of “beeps” with increasing frequency 
will be heard. After using the self timer, the camera automatically returns to normal operation (timer is 
canceled).

• Video Mode: (       ) : This mode sets the camera to take short video clips (.avi files) rather than still 
photos. With the movie camera icon displayed, press SNAP to begin shooting the video. The counter will 
show elapsed seconds . Press SNAP again to stop shooting the video. The counter will advance by one 
number, as a new file (video) has been stored in the internal memory. After shooting the video clip, the 
camera reverts back to normal still photo operation (assuming unused memory remains). Repeat the 
steps to set AVI mode again if you wish to shoot more video clips.

• Continuous Shot ( CS ) : Takes rapid series of 3 consecutive photos, approx. 1 second apart, when you 
press and hold the SNAP button. You will hear a short beep when each photo is taken.  As with the timer, 
the camera will return to normal operation after the shots are taken, cancelling the CS mode. 

• Delete All (       ) : With this mode is selected, press SNAP once, and the number of total photos in 
memory will blink in the display. Press the SNAP button a second time to erase the entire memory 
contents.  If SNAP is not pressed a second time while the photo counter is blinking, the camera will 
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File Size/Resolution (1-4 Stars): High resolution (3 or 4 stars) settings are recommended for 
best results, but low resolution can be used if you need to shoot a greater quantity of photos 
before downloading, and quality is not a high priority.

Quality (Hq or Lq) : Select “Hq” for High Quality photos (recommended setting, least amount 
of file compression). Select  “Lq” (Low Quality) to store more photos in memory but with a 
slight loss in quality due to greater file compression.

USB Mode (STO or PCC): Always select “STO” , allowing you to download and view the photos 
in the camera’s memory when it is connected to your PC with a USB cable (included). “PCC” 
is a live PC camera option that is was not implemented in this camera model (software is not 
supplied or available for this application), as the camera has a fixed focus preset for distances 
of 30 feet or greater. 

Power Frequency (60 or 50 Hz): This sets the correct electrical line frequency to avoid any 

return to normal operation in a few seconds (all your photos will not be deleted). When the process is 
complete, the photo number display will reset to zero. If no button is pressed for 5 seconds, the camera 
returns to stand-by. “Delete All” is a quick way to clear the memory following a download of your 
photos to a computer, so that the camera is ready to hold as many new photos as possible.

• Delete One (      ) : Pressing SNAP when the “Delete One” icon is displayed will delete (erase) only the 
last photo you took from the camera’s memory. 

•   SETUP Menu (SET):  Pressing SNAP when “SET” is displayed will enter the Setup Menu display, 
which has four different settings, each with two options available. Use the MODE button to cycle 
through the four settings. Pressing the SNAP button will switch (“toggle”) between the two options per 
setting. The four settings (plus “ESC” to exit the setup menu) are displayed in the following order:

CHANGING OPERATIONAL MODES continued
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SETUP Menu continued

visible “flickering” in the images, especially when shooting video clips where fluorescent lighting 
is present. The “60” setting should be used for operation in the United States. If you are using the 
camera in a country with 50 Hz (cycle) AC power frequency, press SNAP to select “50” instead. 

Escape (ESC): Select ESC and press SNAP to exit the Setting menu options, and return to normal 
mode.

OTHER DISPLAY ICONS
• Battery Indicator (         ) : Shows the amount of battery life left. When half of the icon is filled in, you 

should plan to replace the batteries soon. Be sure to bring an extra set of batteries on a long trip or for 
important events. 

             CAUTION
• Make sure you download all photos (see directions in next section of manual) from the camera before 

removing the batteries for longer than the time it takes to change them. The camera memory is volatile 
(power dependant), and your photos may be lost if the batteries are removed for more than a minute or 
two (a temporary charge will remain long enough to allow changing batteries), or if the batteries are left 
in but allowed to become completely dead.
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Photo Storage Capacity Reference (avg. capacity for settings, +/- 5 photos)
 1 Determines amount of file 
compression
    Hq: High Quality (minimum 
                compression)
     Sq: Standard Quality (medium 
                compression)
           

2 Internal RAM available for 
photo files: approx. 6 MB

Image Size refers to the pixel 
dimensions, or resolution, of the 
digital file. 
 

Actual storage capacity will vary 
based on content of each photo 
file. You may be able to take a few 
photos more or less than the listed 
average capacity. 

Use higher resolution and quality 
settings for photos you may want 
to enlarge or crop later. If required, 
they can always be reduced to a 
smaller file size using your photo 
software. Use lower resolution 
and/or standard quality settings 
if you will only email, insert into 
documents, or make small prints, 
and do not want to resize the file 
later.

Image Size # of Star 
Icons

Megapixels 
(approx)

Quality 1
 Setting

Internal 
Memory 2

256 MB 
SD Card

2034x1728 4 4.0 (Interpolated) High 7 photos 299 photos

4 Standard 11 469

2048x1536 3* 3.1* High* 10 427

3 Standard 14 597

1600x1200 2 1.9 High 15 640

2 Standard 22 939

640x480 1 0.3 (“VGA”) High 116 4,949

1 Standard 168 7,168

Notes

ADDITIONAL SPECIFICATIONS
Video Clip Resolution: 320x240 pixels per frame @10 fps rate, avi file format
Maximum Video Recording Time: determined by available internal or card memory. 
Approx. 5 minutes using full capacity of available internal RAM memory.
Maximum SD Card Capacity: 1 GB (gigabyte), standard speed recommended
Imaging Sensor: 3.14 MP CMOS 
Internal RAM: 8MB, approx 6MB maximum available for photo/video file storage. 
Capacitor maintains memory contents for 1-2 minutes while changing batteries. Use 
of SD card recommended to avoid potential loss of files if batteries become depleted.

* Default settings: 3.1 megapixel resolution (3 stars), High quality (Hq)
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DOWNLOaDiNG THE pHOTOs/ViDEOs TO yOUR COMpUTER:

1. The camera will be recognized as a USB mass storage device (if USB Mode is set to "STO" and not 
"PCC"), which means no special drivers are required for all operating systems later than Windows 98 
(Me, 2000, XP, Vista) Mac OS 9 and OSX are also compatible. If you have a PC running Windows 
98, you must install the driver found on the included CD-Rom BEFORE CONNECTING THE 
CAMERA TO YOUR PC. 

2.  If you have a computer OS as listed above that is USB mass storage compliant, a new disc icon will 
appear in Windows Explorer (under “My Computer”) showing the Imageview as a new “Removable 
Disc” after plugging in the USB cable from the Imageview. Mac users will see the new disc device 
appear on their desktop. Clicking on the new disc icon will show the contents, a folder named 
“DCIM.” The image folder inside this contains your photos, stored as JPEGs (.jpg file format). They 
may then be opened, edited, renamed and saved using any photo or graphics software that accepts 
.jpg files. If you do not have software that will open .jpg files, you should install Roxio PhotoSuite 
(Windows PC only, using Win98/2000/XP) from the included CD-ROM. See “Software Installation” 
for instructions.

3.  After you have copied or opened and saved the photo files to your computers hard drive, you may 
disconnect the Imageview camera (NEVER disconnect the camera while files are still being transferred 
to your computer.) Before disconnecting, you may need to “eject” or stop the removable disc 
representing the camera to avoid an error message on computers runningWindows 2000 or Mac OS. 
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System Requirements (Minimum)

Software Installation 

Transferring The Photos & Videos to Your Computer - Step by Step

OS: Windows® 98/98SE/2000/ME/XP/Vista (Note: the Imageview is compatible with Vista, however, 
the optional Photosuite software is not)
CPU: MMX Pentium® 200MHZ equivalent or faster (Pentium® III 500 MHz for PhotoSuite5™)
Memory: 32MB minimum (64MB recommended for PhotoSuite)
SVGA video card w/2MB VRAM, 800x600 screen display, 16 bit High color
200 MB available hard disk space (if installing PhotoSuite)
Internal USB Port

If you are using Windows 98, you must install drivers before connecting the camera to your PC. Insert the CD-ROM 
into your computer’s CD drive; it will auto-run and the install screen will be displayed. Select “Install Driver”, then 
follow the directions. After installation, restart your computer. Windows 2000, ME, and XP do not require drivers, 
as the camera uses the USB mass storage standard , allowing the photo files to be accessed as if they were stored on 
an external hard drive. For any Windows OS, if you are not already using photo editing software you prefer, you may 
install Roxio PhotoSuite® from the CD-ROM. Be sure to read the “Release Notes” completely, noting any tips or 
potential issues relevant to your PC configuration and OS.

1. Be sure the driver has been installed first if you are on Windows 98/98SE.
2. Connect the supplied cable to the ImageView’s USB port, then directly to a main USB port on your computer-do 
not use front panel/keyboard USB ports or unpowered “hubs”.

WaRNiNG:  Make sure you download any picture from your camera before you remove the 
batteries from the camera.
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Transferring The Photos & Videos to Your Computer -continued

3. The LCD display will indicate “STO”, and the ImageView will be recognized as a standard “USB 
Mass Storage” device. This means that the camera files can be easily viewed, edited, or copied to your 
hard drive, just as if they were stored on an external hard drive or a CD-ROM.  

4. (This step is not required with Windows XP or Vista, simply use the options in the pop-up window to view, 
copy or edit your photos). Open My Computer or Windows Explorer. The camera will be seen as a new 
“Removable Disk” with an unused drive letter assigned to it. Double click this new “Disk” icon, open 
the “DCIM” folder inside, then the folder(s) inside that (“100MEDIA” ,etc). Your photos/videos are 
the files inside-they have the prefix “IMG__” followed by a number, same as seen earlier on the camera’s 
display when you review photos. Single clicking any file should show a small preview image.

5. Click “Edit>Select All” (or click on one photo, contol+click to select multiple photos), then 
“Edit>Copy to Folder” (in Windows menus). Select an existing folder on your hard drive, such as “My 
Pictures”, or create a new folder (“Hawaii Vacation”, etc), then click “OK” to transfer copies of the 
photo files you want.

6. After the photos are transferred to your hard drive, you can disconnect the camera. Windows 2000 
may produce a screen warning that you have disconnected a USB device without stopping or ejecting 
the “disk” first (your photo files will not be harmed). If so, check the box that adds an icon to your 
system tray or taskbar.  Then next time you finish transferring photos, you can click that icon first, and 
“Stop the USB Mass Storage Device” before disconnecting the camera. (On Mac computers, you should 
“eject” the “disk” that represents the camera on the desktop before disconnecting.)
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Transferring The Photos & Videos to Your Computer -continued 
7.  You’re now ready to open the photo files in any photo editing software. Just use File>Open and go to the folder 
where you stored the photos earlier. If you are using PhotoSuite, select File>Open Photo, then use the “Look in” pull 
down menu at the top of the Open window, select “My Computer”, select your hard drive, and double click any 
photo in the folder where you copied the files from the camera. It is also possible to open and work with your photos 
directly from the ImageView while it is still connected.To do this with PhotoSuite, first follow steps 1-3, then open 
PhotoSuite, select File>Open Photo and use the “Look in” menu to select My Computer, then select the “Removable 
Disk”, and open the folders inside until you get to the “___.jpg” photo files. If you choose to work this way, from 
a connected camera, be sure that you save the photo (when you are done editing) to your hard drive, and not the 
camera’s memory or card. To do this in PhotoSuite, after clicking “Done”, answer “Save Changes?” with “Yes”, but 
then answer “Replace Existing File”? with “No” and use the “Save As” dialog box to save the edited photo in a folder 
on your hard drive (“Save In>Local Disk”), not the “Removable Disk” (camera). 

8. If you are new to photo editing on a computer, consult your software’s Help menu (PhotoSuite has extensive 
built-in Help) for tips on using its features. Along with adjusting the brightness, contrast, sharpness and color of 
your photos, you can resize the photo to fit the paper if you are printing, or save a smaller, low or medium resolution 
version for email or inserting into documents. When you are ready to save your edited file, you may want to use 
“Save As” and give it a more descriptive name than “IMG___”. Doing this also preserves the original file as a backup 
to reopen and re-edit later.  Make sure you have successfully transferred all the photos you wanted to save before 
using “Delete All” on your camera to make room for new images.
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 BiNOculAr iNStructiONS
 
Your Bushnell binocular is a precision instrument designed to provide many years of pleasurable 
viewing. this portion of the booklet will help you achieve optimum performance by explaining how 
you can adjust the binocular to your eyes, and how to care for this instrument. Read the instructions 
carefully before using your binocular.

EYE ADJuStMENtS (Figure 1)
How to Adjust For Distance Between Your Eyes
the distance between the eyes, called “interpupillary distance,” varies from person to person. to 
achieve perfect alignment of lens to eye, follow these simple steps.
   
1.  Hold your binocular in the normal viewing position.
2.  Grasp each barrel firmly. Move the barrels closer together or 

further apart until you see a single circular field. Always re-set your 
binocular to this position before using.

How to Adjust For individual Eye Strength
As individual eyesight varies from one person to another, Bushnell binoculars have a diopter setting 
feature which allows you to fine-tune the binocular to your vision. Follow the focusing instructions 
below for your binocular.

iNtERPUPiLLARY DiStANCE

Fig. 1
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FOcuSiNG
1.  Adjust interpupillary distance. (Figure 1)
2.  Set the “diopter setting” (Figure 2) to zero and view a distant object.
3.  Keep both eyes open at all times.
4.  Using a lens cover or your hand, cover the objective (front) lens of the 

same side of the binocular that has the “diopter setting.” this is usually 
the right side. 

5.  Using the center focus wheel, focus on a distant object with fine detail (e.g., brick wall, tree 
branches, etc.) until it appears as sharp as possible.

6.  Uncover the objective lens on the diopter side, cover the other objective lens, then view the same 
object.

7.  Using the “diopter setting” adjustment ring, focus the same object being viewed. Caution should 
be used as over turning or forcing the diopter eyepiece can cause damage or cause the eyepiece 
to break away from the chassis.

8.  Your binocular should be adjusted for your eyes. Focus at any far or near distances can now be 
attained simply by turning the center focus wheel.  Make a note of the diopter setting for your 
eyes for future reference.

EYEcuPS (Figure 3)
Your Bushnell binocular is fitted with rubber roll-down eyecups designed 
for your comfort and to exclude extraneous light. if you wear sun/
eyeglasses, roll down the eyecups. this will bring your eyes closer to the 
binocular lens thus providing improved field of view.

DiOPtER  SEttiNG

Fig. 2

ROLL-DOWN  EYECUPS

Fig. 3
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iNStructiONS FOr cArE OF BiNOculArS
Your Bushnell binocular will provide years of trouble-free service if it receives the normal care you 
would give any fine optical instrument. Non-waterproof models should not be exposed to excessive 
moisture.

1.  if your binocular has roll-down, flexible eyecups, store it with the eyecups up. this avoids 
excessive stress and wear on the eyecups in the down position.

2.  Avoid banging and dropping.
3.  Store in a cool, dry place.
4.  CAUtiON:  Looking directly at the sun with your binocular may be very harmful to your eyes.
5.  Never expose your imageView binocular to any type of excessive of liquid or fluid, as the 

binocular is not water/fogproof.
6.  take the batteries out of your imageView if you are not going to use it for a long period of time.  

(Make sure you download any pictures from your camera before you remove the batteries from 
the camera.)

clEANiNG
1.  Blow away any dust or debris on the lens (or use a soft lens brush).
2.  to remove dirt or finger prints, clean with a soft cotton cloth rubbing in a circular motion. Use 

of a coarse cloth or unnecessary rubbing may scratch the lens surface and eventually cause 
permanent damage. A “microfiber” cleaning cloth (available at most photo dealers) is ideal for 
the routine cleaning of your optics.

3.  For a more thorough cleaning, photographic lens tissue and photographic-type lens cleaning 
fluid or isopropyl alcohol may be used. Always apply the fluid to the cleaning cloth – never directly on 
the lens.
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Notes
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TWO-Year LIMITeD WarraNTY
Your Bushnell® product is warranted to be free of defects in materials and workmanship for two years after 
the date of purchase. In the event of a defect under this warranty, we will, at our option, repair or replace 
the product, provided that you return the product postage prepaid. This warranty does not cover damages 
caused by misuse, improper handling, installation, or maintenance provided by someone other than a Bushnell 
Authorized Service Department.
Any return made under this warranty must be accompanied by the items listed below:

 1) A check/money order in the amount of $10.00 to cover the cost of postage and handling
 2) Name and address for product return
 3) An explanation of the defect
 4)   Proof of Date Purchased
 5)  Product should be well packed in a sturdy outside shipping carton, to prevent 
       damage in transit, with return postage prepaid to the address listed below:

 IN U.S.a. Send To:   IN CaNaDa Send To: 
 Bushnell Outdoor Products Bushnell Outdoor Products 
 Attn.:  Repairs  Attn.:  Repairs
 8500 Marshall Drive  25A East Pearce Street, Unit 1
 Lenexa, Kansas 66214 Richmond Hill, Ontario L4B 2M9

For products purchased outside the United States or Canada please contact your local dealer for applicable 
warranty information. In Europe you may also contact Bushnell at:  
     Bushnell Germany GmbH
     European Service Center
     Mathias-Brüggen-Str. 80  
     GERMANY  
     D- 50827 Köln
     Tel: +49 221 995568-0
     Fax: +49 221 995568-20

This warranty gives you specific legal rights. 
You may have other rights which vary from country to country.

©2007 Bushnell Outdoor Products

FCC Note:
This equipment has been tested and found to comply 
with the limits for a Class B digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful 
interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio 
or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the 
following measures:
· Reorient or relocate the receiving antenna.
· Increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on a circuit  
 different from that to which the receiver is connected. 
· Consult the dealer or an experienced radio/TV  
 technician for help.

The shielded interface cable must be used with the 
equipment in order to comply with the limits for a digital 
device pursuant to Subpart B of Part 15 of FCC Rules.

Specifications and designs are subject to change without 
any notice or obligation on the part of the manufacturer. 
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For further questions or additional information please contact:

Bushnell Outdoor Products
9200 Cody, Overland Park, Kansas 66214

(800) 423-3537  •  www.bushnell.com

INNOVATION THAT THRIVES OUTSIDE
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